
Ψηφιακό σχέδιο/CΑD
Διάλεξη:
Ευαγγελία Φραγγεδάκη, αρχιτέκτων μηχανικός, ΕΔΙΠ



Λογισμικά σχεδίασης

 Εταιρικά λογισμικά, κλειστού κώδικα

(π.χ.Autocad)

 Ελεύθερα λογισμικά, Ανοικτού κώδικα

(Οpen Source Software), π.χ. FreeCad, Blender 

κ.ά.

Διανέμονται δωρεάν, με ειδικές άδειες χρήσης 
(τύπου GPL) και υπάρχει ελεύθερη πρόσβαση στον 
κώδικα.



AutoCad
Σχεδίαση σε 2 ή 3 
διαστάσεις
Διαδεδομένη πλατφόρμα ψηφιακής σχεδίασης

ΣΤΟΧΟΣ:
Χρήση και Διαχείριση αρχείων AUTOCAD
Ψηφιακός Σχεδιασμός, 
Αντιγραφή Σκίτσου-Αποτύπωσης,



Σχεδίαση 
με ηλεκτρονικό υπολογιστή

Τα λογισμικά σχεδίασης με H/Y καταργούν την τομή 
που υπάρχει ανάμεσα στους δύο τρόπους σχεδίασης, 
συνδυάζοντας τις δισδιάστατες και τις τρισδιάστατες
απεικονίσεις. 

 Έτσι, είναι δυνατόν να έχουμε ταυτόχρονα τα 
δισδιάστατα σχέδια (κατόψεων, τομών και όψεων) και 
την τρισδιάστατη εικόνα του κτιρίου με αξονομετρικά 
και προοπτικά (π.χ. Archicad).

 Με ειδικά προγράμματα (π.χ.3dMAX) μπορούμε να 
κινηθούμε γύρω από το κτίριο και μέσα στους χώρους 
του, δημιουργώντας συνθήκες που προσομοιάζουν 
στην πραγματικότητα. 



AutoCad 
Σχεδίαση σε 2 διαστάσεις

 Για τη μελέτη, τη σχεδιαστική περιγραφή, 

την παρουσίαση και την κατασκευή ενός 

κτιρίου ή ενός χώρου, είναι απαραίτητος ένας 

τρόπος αναπαράστασής τους υπό κλίμακα με 

τον οποίο θα έχουμε ακριβή αντίληψη, 

έλεγχο και χειρισμό

 των πραγματικών μεγεθών, 

 γωνιών και μορφών, 

 γραμμών και των σχημάτων.

http://ebooks.edu.gr/



Το ψηφιακό σχέδιο

 Όταν σχεδιάζουμε στον υπολογιστή, κάθε γραμμή 
αποτελεί ένα αυτόνομο αντικείμενο. 

 Το μήκος, το σχήμα της, το χρώμα της εμφανίζονται, στην 
οθόνη, αλλά στην πραγματικότητα ορίζονται ως δεδομένα στη 
μνήμη του υπολογιστή 

 Είναι δυνατόν να αλλάξουμε με μία απλή εντολή αυτά τα 
δεδομένα και η γραμμή να αποκτήσει άλλο μήκος, σχήμα ή 
χρώμα.

 Οι εντολές του προγράμματος επεμβαίνουν στην κατάσταση 
του και αλλάζουν τις ιδιότητες του στην μνήμη του υπολογιστή, 
και στη συνέχεια το αντικείμενο εμφανίζεται αλλαγμένο στην 
οθόνη. 



Δισδιάστατες απεικονίσεις

Με σύστημα ορθών προβολών, 

σχεδιάζονται συνδυασμένα 

κατόψεις, τομές και όψεις.







• Close: Μετατροπή ανοιχτής polyline σε κλειστή. Αν η polyline είναι 
κλειστή η επιλογή αυτή αντικαθίσταται με την Open (μετατροπή 
κλειστής σε ανοιχτή polyline).

• Join: Προσθήκη γραμμών, τόξων ή άλλων polylines σε υπάρχουσα 
polyline.

• Width: Ορισμός νέου ομοιόμορφου πάχους για όλα τα τμήματα.

• Edit vertex: Δυνατότητα επεξεργασίας μεμονωμένων τμημάτων. Με 
την επιλογή αυτή ο πρώτος κόμβος μαρκάρεται με Χ και εμφανίζεται 
η προτροπή: Enter a vertex editing option

[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/e
Xit]

• Next, Previοus, Break, Insert,επιλεγμένο σημείο.

• Move: Μετακίνηση κόμβου σε νέα θέση.

Τροποποίηση Polyline



 DIST ή DI (Tools, Inquiry, Distance)

 Μετρά την απόσταση μεταξύ δυο σημείων στο σχέδιο.

 Με αυτό τον τρόπο μπορούμε να επιβεβαιώσουμε αν 

σχεδιάσαμε σωστά, ή να πάρουμε άλλες διαστάσεις που 

προκύπτουν γραφικά από το σχέδιό μας.

 AREA (Tools, Inquiry, Area) 

 Μετρά την επιφάνεια που ορίζεται από ένα σύνολο σημείων ή 

από μια κλειστή.

 ID (Tools, Inquiry, ID Point)

 Μας δίνει τις συντεταγμένες του σημείου που επιλέγουμε.

ΠΛΗΡΟΦΟΡΙΕΣ ΓΙΑ ΤΑ ΑΝΤΙΚΕΙΜΕΝΑ 
ΤΟΥ ΣΧΕΔΙΟΥ



ΠΛΗΡΟΦΟΡΙΕΣ ΓΙΑ ΤΑ ΑΝΤΙΚΕΙΜΕΝΑ 
ΤΟΥ ΣΧΕΔΙΟΥ

 LIST ή LI (Tools, Inquiry, List)

 Μας δίνει πληροφορίες για τα αντικείμενα που επιλέξαμε 

(γεωμετρικά

 χαρακτηριστικά και ιδιότητες –layer, χρώμα, τύπο 

γραμμής), στην οθόνη κειμένου.



Επικρατέστερες
Εντολές επεξεργασίας



Ποιες είναι οι βασικές εντολές 
Επεξεργασίας - Τροποποίησης;

 Επιλογή αντικειμένων, 

 Διαγραφή, Αντιγραφή,

 Μετακίνηση,

 Κατοπτρισμός

 Τροποποίηση μήκους

 Σύνδεση 

 Απότμηση, διαίρεση, διακοπή, 
γραμμών, 

Select, Getsel, Erase, Copy, Offset, Move, Trim, Extrim, 
Extend, Change, Properties, Lengthen

Διεργασίες που μπορούν
να γίνουν με τα
παραπάνω εργαλεία



Εντολές προγράμματος

 ταινία με τις καρτέλες 

(ribbon, tabs )

o Πληκτρολόγηση εντολών ή 
συντομέσεων



Γραμμή πληκτρολόγησης

Γραμμή  Εντολών



Quick access



Διαδικασία σχεδίασης

Βήμα-βήμα

 Η γεωμετρία και τα στοιχεία της κάτοψης 

καθορίζουν τον τρόπο, με τον οποίο αυτή σχεδιάζεται. 

 Ξεκινάμε με τα συνεχή στοιχεία (polyline) και 

προχωρούμε με όσα περιλαμβάνονται σ'αυτά ή 

καθορίζονται απ'αυτά. 

 Συνήθως σχεδιάζουμε το ορθογώνιο, στο οποίο

εγγράφεται η κάτοψη. 



Κλίμακα σχεδίασης

 Σε περιβάλλον CAD σχεδιάζουμε σε μέτρα!!!

 Εφόσον στόχος μας είναι να δείξουμε τη μορφή και την οργάνωση του 

κτιρίου χρησιμοποιούμε συνήθως την κλίμακα 1:50. 

Η κλίμακα σχεδίασης επηρεάζεται από το μέγεθος των κτιρίων και από 

τον προορισμό των σχεδίων, ανάλογα με το στάδιο της μελέτης, στο 

οποίο βρισκόμαστε. 

Έτσι, για μεγάλα κτίρια ή συγκροτήματα χρησιμοποιούμε τις κλίμακες 

1:100 ή 1:200. Αντίθετα, στη μελέτη εφαρμογής ή για να 

παρουσιάσουμε λεπτομερέστερα ένα χώρο, σχεδιάζουμε σε κλίμακες 

1:20 ή 1:10. 



Τοπογραφικό Σχέδιο

 Σχέδιο γενικής κάτοψης, στο οποίο δείχνουμε τη σχέση του

κτιρίου με το περιβάλλον, φυσικό και τεχνητό. 

 Στοιχεία που φαίνονται σε ένα τοπογραφικό είναι:

-ο προσανατολισμός, τα όρια (του οικοπέδου και η θέση του 

κτιρίου σ'αυτό),

-υπαίθριες διαμορφώσεις, 

-τα γύρω κτίρια και οι δρόμοι, 

-οι υψομετρικές καμπύλες - που δείχνουν το ανάγλυφο του

εδάφους - φυσικά στοιχεία



π.χ. Σχεδιαζω τις 
ισοϋψεις με 
Polyline και τις 
μετατρέπω σε 
καμπύλες



Αρχιτεκτονικό Σχέδιο

 Σχέδια Κάτοψης,Τομής, Όψης στο οποίο δείχνουμε τη δομή του 

κτιρίου.

 Στοιχεία που φαίνονται στο αρχιτεκτονικό σχέδιο είναι:

-ο προσανατολισμός (block), 

-τα όρια του κτιρίου (lines)

-εσωτερικές διαμορφώσεις, (lines+block).



Μηχανολογικό Σχέδιο

 Σχέδια Kάτοψης,Τομής, 

Όψης και Άνοψης στο

οποίο δείχνουμε τις Η/Μ 

εγκαταστασεις του κτιρίου.

 Στοιχεία που φαίνονται στο 

μηχανολογικό σχέδιο είναι:

-τα δίκτυα του κτιρίου

(lines)

- οι εγκαταστάσεις

(block)
Πυρανίχνευση



Η γραμμή





1. Bασικές Eντολές Διαχείρισης 

Εννοούμε την εκτέλεση ενεργειών, που 

εισάγουν, εξάγουν, αποθηκεύουν, 

αντικείμενα του σχεδίου ή ολόκληρα 

σχέδια (με βασικότερες  Open & 

Save, Save as (επιλογή έκδοσης 

Autocad)

2.Πίνακας Ελέγχου και 

χαρακτηριστικών 

αντικειμένων

Εννοούμε τις ιδιότητες των 

αντικειμένων που βρίσκονται 

σε μορφή πίνακα  Properties 

– (συντομ.CTRL+1)

Βασικές Εντολές Επεξεργασίας



3. Εντολές Ελέγχου

αντικειμένων Εννοούμε την εκτέλεση 

ενεργειών, που αλλάζουν αντικείμενα 

του σχεδίου (με βασικότερες  Erase & 

Selection Sets,Copy)

4.Εντολές Ελέγχου της

απεικόνισης

Εννοούμε την εκτέλεση 

ενεργειών, που αλλάζουν την 

απεικόνιση των αντικειμένων 

του σχεδίου (με βασικότερες  

Zoom & Pan )Επίσης τροποποιήσεις  γίνονται από:

 την Παλέτα ιδιοτήτων

 τις  Λαβές αντικειμένων

Βασικές Εντολές Επεξεργασίας



Εντολές Μετατροπής & Τροποποίησης

 Απαιτούν την επιλογή των αντικειμένων στις οποίες θα εφαρμοστούν. 

 Μετά την επιλογή, για την εκτέλεση της εντολής πατήστε “Enter” ή δεξί

κουμπί του mouse.

*Κλικ σε μεμονωμένα αντκείμενα ή ομάδες (Object Selection)

*Ορθογώνιο επιλογής (Marquee)

*Αφαίρεση επιλογής με shift



Προστασία φακέλου εργασιών

 >Tools

 >Options

Save as:

επιλογή έκδοσης CAD από 

το Tab ‘OPEN and SAVE’

 >Tools
 >Options

File Safety Precautions:
 Automatic Save

π.χ. Κάθε 10λεπτά
 Create backup copy (file 

extension ac$)



Εντολές επιλογής

Selection



Εντολές
Ελέγχου της απεικόνισης

ZOOM ή Z (View, Zoom) 

Αλλαγή του μεγέθους της άποψης του σχεδίου. Μπορούμε να

δούμε μικρότερο ή μεγαλύτερο τμήμα του σχεδίου στην οθόνη , 

οπότε αλλάζει και το μέγεθος των αντικειμένων, χωρίς να

αλλοιωθεί το πραγματικό (σχεδιασμένο) μέγεθος. 

REDRAW ή R (View, Redraw)

Ξανασχεδιάζεται το σχέδιο στην οθόνη προκειμένου να

εξαλειφθούν σημάδια από τη χρήση άλλων εντολών που δεν

αποτελούν μέρος του σχεδίου. 



Εντολές
Ελέγχου της απεικόνισης

PAN ή P (View, Pan)
Μετακίνηση της άποψης του σχεδίου σε νέα θέση. 

REGEN ή RE (View, Regen)
Ξανασχεδιάζεται το σχέδιο , με επαναϋπολογισμό όλων
των αντικειμένων του σχεδίου. 
Χρησιμοποιούμε την εντολή αυτή προκειμένου να
εμφανιστούν σωστά κάποια αντικείμενα
(π .χ. Καμπύλες που φαίνονται τεθλασμένες ,
διακεκομμένες που φαίνονται συνεχείς ), είτε
για να γίνει ενημέρωση αντικειμένων από την αλλαγή
σε κάποιες ρυθμίσεις ( π.χ. στο point style). 



 COPY ή CO (Modify, Copy) 

Εντολή δημιουργίας αντιγράφων επιλεγμένων 

αντικειμένων. (base point of displacement)

Επιλογές:

Select objects: Επιλογή αντικειμένων (τερματίζεται με Enter)
Specify base point or displacement, or [Multiple]: ορισμός 

πρώτου σημείου του διανύσματος μετατόπισης ή [Εναλλακτικές 
επιλογές]

Specify second point of displacement or <use first point as 
displacement>: ορισμός δεύτερου σημείου του διανύσματος 
μετατόπισης

Multiple: Πολλαπλά αντίγραφα

ΕΡΓΑΛΕΙΑ ΤΡΟΠΟΠΟΙΗΣΗΣ
Εντολές Ελέγχου αντικειμένων



ΕΦΑΡΜΟΓΗ
 Σχεδιάστε ένα κύκλο 
>Draw>Circle>Radius, centre
Στη θέση χ=0, ψ=10 και ακτίνα 5!

 Αντιγράψτε τον κύκλο και δημιουργείστε ~10 νέους σ’ 

όλη την επιφάνεια εργασίας.

 Δοκιμάστε να τους επιλέξετε με: 

Window Selection, Crossing Window Selection, Fence 

Selection

 Διαγράψτε 2 κύκλους, >Modify >Erase

 UNDO



Αλλαγή θέσης, διεύθυνσης, μεγέθους 
αντικειμένων

 MOVE ή Μ (Modify, Move)

Μετακίνηση αντικειμένου σε νέα θέση με βάση ένα 

διάνυσμα μετατόπισης που ορίζεται δίνοντας δυο σημεία. 

Έχει ακριβώς την ίδια σύνταξη με την εντολή Copy.

Επιλογές: 

Select objects: Επιλογή αντικειμένων (τερματίζεται με Enter)

Specify base point or displacement: ορισμός πρώτου σημείου 

του διανύσματος μετατόπισης

Specify second point of displacement or <use first point as 

displacement>: ορισμός δεύτερου σημείου του διανύσματος



Αλλαγή θέσης, διεύθυνσης, μεγέθους 
αντικειμένων

 ROTATE ή RO (Modify, Rotate) 

Περιστροφή αντικειμένων γύρω από σημείο με δεδομένη 

γωνία.

Select objects: Επιλογή αντικειμένων (τερματίζεται με Enter)

Specify base point: Κέντρο περιστροφής

Specify rotation angle or [Reference]: Γωνία περιστροφής ή 

[Εναλλακτικές επιλογές]

Reference: καθορισμός γωνίας βάση μια διεύθυνση αναφοράς.



Αλλαγή θέσης, διεύθυνσης, μεγέθους 
αντικειμένων

 SCALE ή SC (Modify, Scale) 
Μεταβολή του μεγέθους αντικειμένων σύμφωνα με κάποιο 

συντελεστή.
Επιλογές:
Select objects: Επιλογή αντικειμένων (τερματίζεται με Enter)
Specify base point: Το σημείο που θα μείνει σταθερό κατά 

τη μεταβολή.
Specify scale factor or [Reference]: Ο συντελεστής ή 

[Εναλλακτικές επιλογές]. Άν ο συντελεστής είναι 
μεγαλύτερος της μονάδας έχουμε μεγέθυνση, άν είναι 
μικρότερος σμίκρυνση.

Reference: καθορισμός του μεγέθους σύμφωνα με μια άλλη  
αναφορά.



Αλλαγή θέσης, διεύθυνσης, μεγέθους 
αντικειμένων

 STRETCH ή S (Modify, Stretch)
Παραμόρφωση αντικειμένων (αλλαγή θέσεων των άκρων 
τους) σύμφωνα με δοσμένο διάνυσμα. 

Επιλογές:

Select objects: πρέπει να γίνει με μια κίνηση και με παράθυρο

Crossing ή Crossing Polygon)

Specify base point or displacement: ορισμός πρώτου σημείου του 
διανύσματος μετατόπισης και Specify second point of 
displacement

Παρατηρήσεις: • Τα άκρα των γραμμών που βρίσκονται μέσα στο 
παράθυρο επιλογής μετατοπίζονται κατά το διάνυσμα μετατόπισης. 
• Κατά συνέπεια αν μια γραμμή έχει και τα δυο άκρα της μέσα στο 
παράθυρο μετατοπίζεται παράλληλα προς τον εαυτό της. 



ΕΦΑΡΜΟΓΗ

 Απενεργοποιήστε τις λειτουργίες dynamic input (μπάρα 

εντολών κάτω)

1.>επιλέξτε τα δύο πάνω σημεία 

του ορθογωνίου

2. >Stretch stretch point or 

[base point/copy/undo/exit]

 Ενεργοποιήστε Osnap και 

τραβήξτε μέχρι το άκρο του τόξου



ΕΦΑΡΜΟΓΗ
 Σχεδιάστε ένα παραλληλόγραμμο

>Draw>Rectangular
Στη θέση χ=0, ψ=10

 Επιλέψτε τις 2 επάνω κορυφές (cross window) και 

εφαρμόστε Stretch.

 Επιλέψτε όλο το σχήμα και εφαρμόστε Stretch

 Εφαρμόστε την εντολή Scale (π.χ.x2, x0.5, reference )



 ERASE ή Ε (Modify, Erase)

Εντολή διαγραφής των επιλεγμένων αντικειμένων. Διαγραφή 

αντικειμένων από το σχέδιο. Η εντολή ζητά επιλογή 

αντικειμένων. Μετά την ολοκλήρωση της επιλογής με Enter 

ολοκληρώνεται και η εντολή και τα αντικείμενα σβήνονται.

 UNDO ή U (Edit, Undo), REDO (Edit, Redo)

 OOPS (Επαναφέρει τα αντικείμενα που σβήστηκαν με την 

τελευταία εντολή ERASE, (ανεξάρτητα αν έχουν 

χρησιμοποιηθεί και άλλες εντολές στο μεταξύ).

ΕΡΓΑΛΕΙΑ ΤΡΟΠΟΠΟΙΗΣΗΣ
Εντολές Ελέγχου αντικειμένων



ΕΡΓΑΛΕΙΑ ΤΡΟΠΟΠΟΙΗΣΗΣ
Εντολές Ελέγχου αντικειμένων

 OFFSET ή O (Modify, Offset)
Δημιουργία νέου αντικειμένου παράλληλου προς το αρχικό σε 
δεδομένη απόσταση ή που να περνά από δεδομένο σημείο. 
(Εφαρμόζεται σε γραμμές, τόξα, κύκλους, polylines).
Επιλογές:
Specify offset distance or [Through] <Through>: Ορισμός της 
απόστασης ή [Εναλλακτική επιλογή] <Προτεινόμενη επιλογή> (αυτή 
που χρησιμοποιήθηκε την τελευταία φορά)
Select object to offset or <exit>: Επιλογή αντικειμένου προς 
αντιγραφή ή Enter για τερματισμό της εντολής
Specify point on side to offset: Σημείο στην πλευρά προς την 
οποία θα αντιγραφεί το αντικείμενο (υπάρχουν δυο πιθανές θέσεις 
κάθε φορά). 



Σχεδιάστε το παρακάτω, 
εφαρμόζοντας τις προηγούμενες εντολές



 MIRROR ή MI (Modify, Mirror)
Δημιουργία αντιγράφου ενός αντικειμένου, 
συμμετρικού ως προς άξονα σε σχέση με το αρχικό.

Επιλογές:
Select objects : τερματίζεται με Enter
Specify first point of mirror line: Ορισμός πρώτου 
σημείου απ’ όπου διέρχεται ο άξονας 
συμμετρίας.
Specify second point of mirror line: Ορισμός 
δεύτερου σημείου απ’ όπου διέρχεται ο άξονας 
συμμετρίας.
Delete source objects? [Yes/No] <N>:

ΕΡΓΑΛΕΙΑ ΤΡΟΠΟΠΟΙΗΣΗΣ
Εντολές Ελέγχου αντικειμένων



 ARRAY ή AR (Modify, Array)

Αντιγραφή αντικειμένου σε ορθογωνική ή κυκλική διάταξη.

Περιγραφή για ορθογωνική διάταξη με τα δεδομένα που πρέπει 

να εισαχθούν είναι:

• Αριθμός γραμμών και στηλών

• Οριζόντια και κατακόρυφη απόσταση μεταξύ των 

αντικειμένων (αριθμητικά: distance between rows -

distance between columns ή γραφικά unit cell)

Διάταξη κατά τη θετική φορά x και y εκτός αν οριστούν αρνητικές αποστάσεις.

ΕΡΓΑΛΕΙΑ ΤΡΟΠΟΠΟΙΗΣΗΣ
Εντολές Ελέγχου αντικειμένων




